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This job aid is available online: 
• In the Public Folders: 

All Public Folders > Statewide > Connections > Build 15.1 
• On the CONNECTIONS Intranet site: 

DFA Intranet Site > OCFS Homepage > Connections > Desk and Job Aids 
The CONNECTIONS Intranet site also contains information about CONNECTIONS training. 

Note: Any visible identifying data in this job aid is simulated.  
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Introduction 

This Job Aid provides information on a new process in CONNECTIONS called “Vacancy 
Control.” Vacancy Control is being introduced as part of Build 15.1 and is designed to 
provide local district and voluntary agency workers with real time access to vacant bed 
information that meets the needs of the children in need of placement. Workers will be able 
to search for bed vacancies and maintain bed level vacancies and bed characteristics in 
Foster Boarding Homes (FBH) or Congregate Care Facilities (CCF) that they authorize. 
Kinship Homes are not included in Vacancy Control. 

Several windows have been created to help workers search for available beds and maintain 
new or existing beds and bed characteristics in facilities. These windows include: 

• Vacancy Control - Search ―Provides workers with the ability to search for an 
available bed based on the information entered for the type of facility and bed 
desired. Only facilities in active status are returned in a search. 

• Vacancy Control - Bed Detail ―Provides workers with the ability to view all 
beds in a selected facility. Workers are able to select a Vacant bed(s) and 
“Reserve” or “Occupy” the bed(s) for a child or children in need of placement. 
Workers who reserve a bed (or a staff person in the unit hierarchy) are also able 
to change the status to Unreserve within the two-hour time limit for bed holds. 

• Vacancy Control - Bed Maintenance ―Provides workers with the ability to 
maintain beds (e.g., add beds, delete beds, modify bed characteristics) for a 
facility in accepted, active or applicant status. Performing this function in a timely 
manner allows agencies to optimize their placement potential. 

• Vacancy Control - Closed To Intake ―Provides designated OCFS and local 
district staff with the ability to remove facilities from the Vacancy Control Facility 
Search Results. The Closed To Intake status can be applied to a single facility, 
all facilities within an agency or a facility type within an agency  

• Vacancy Control - CD/Borough Award ―Provides NYC/ACS workers with the 
ability to maintain data that indicates which agencies have been awarded a 
neighborhood based service contract.  

• Updates to the CONNECTIONS Online Help system ―Build 15.1 continues 
the development of the CONNECTIONS Online Help system. Online Help has 
been updated to reflect enhancements made to the CONNECTIONS system as a 
result of Vacancy Control.  

In addition, two reports have been created to help track placement or notify individuals of 
Closed To Intake status changes applied to facilities.  

• Vacancy Control Placement Tracking Report ― Caseworkers and supervisors 
are able to create a report that contains information on selected beds that are in 
Occupied status.  

• Vacancy Control Closed To Intake Report ―Contains statewide information on 
facilities that have a Closed To Intake status. This report is available to all staff 
on the Closed To Intake Distribution List. The distribution list is maintained by 
NYS/OCFS. 

CONNECTIONS - System Build 15.1 – Vacancy Control Page 4 

7/24/02 



 

Vacancy Control Security Access 
Your Business Function Profile (BFP) determines what you are able to view and the tasks 
you are able to perform in CONNECTIONS. Three new Business Functions have been 
added to CONNECTIONS. These new Business Functions can only be applied to OCFS 
staff or workers from local districts and voluntary agencies that have chosen to participate in 
Vacancy Control.  

The following table describes the new Business Functions.  

Business Function  Provides workers with the ability to: 

Vacancy Control Search BF — • Search for beds using the Vacancy 
Control Search window.  

• Modify the Bed Status, Child Info and 
Date Bed Expected Vacant fields in 
the Vacancy Control Bed Detail 
window. 

• View the Vacancy Control Closed To 
Intake window in inquiry mode. 

• View the Vacancy Control 
CD/Borough Award window in inquiry 
mode. 

 

Vacancy Control Bed  
Maintenance BF — 

• Access the Vacancy Control Bed 
Maintenance window in modify mode. 

 

Vacancy Control CD Awards/ 
Closed to Intake Maintenance  
BF — 

• Access the Vacancy Control 
CD/Borough Award window in modify 
mode (NYC/ACS workers only).  

• Access the Vacancy Control Closed 
To Intake window in modify mode.  
 

 

Note: Workers assigned to a FAD stage are able to view the Vacancy Control Bed 
Maintenance window from the Task List. This provides FAD workers who are not designated 
to maintain Vacancy Control with access to information contained in Vacancy Control that 
may be relevant to certification and licensing information. 

Contact your security coordinator if you have questions regarding your security access. 
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Vacancy Control Conversion 
All Foster Boarding Homes licensed by NYC/ACS or licensed by a voluntary agency which 
has a contract with NYC/ACS that are in Accepted-Active status will be pre-loaded into the 
Vacancy Control Bed Detail window using data already existing in CONNECTIONS. In 
addition, NYC/ACS and participating voluntary agencies were given the opportunity to 
submit additional bed-specific information on a spreadsheet to be included when the system 
goes live.  

The bed records for Congregate Care Facilities will also be pre-loaded in Vacancy Control. 
The status of all beds in Congregate Care Facilities will be “Occupied.” The licensed age 
range and number of beds will match the facilities licensing information. 

The following list identifies the information that was submitted by agencies prior to the 
implementation of Vacancy Control. This information was used to update Foster Boarding 
Homes: 

• Bed Status — The status of each bed. 

• Bed Location — An identifier that clarifies the location of the bed (e.g., “A1-2 Ther” 
stands for Bedroom A, Bed 1 of 2 and Therapeutic Contract. This information is 
required for homes with vacancies). 

• Child Info — The child’s gender and age (e.g., M 12/06/91) entered in the first 10 
spaces of the 25-character field. 

• Preferred — This information is used to distinguish the foster parents preferred age 
ranges when they are different from the licensed age range. This information must 
be within the CONNECTIONS licensed age range and will supersede the licensed 
age ranges in a Vacancy Control Search.  

• Severity Rating — The following choices represent the severity levels for Physical, 
Learning, Emotional and Behavioral: 

0 — NA (no known condition or problem) 
1 — Mild 
2 — Moderate 
3 — Severe 

For AIDS, the choices are: 

Yes — the home has agreed to accept children with HIV/AIDS. 
No — the home has not agreed to accept children with HIV/AIDS. 

Beds that were not updated during the conversion process should be updated once 
Vacancy Control goes live. Workers responsible for maintaining bed information can update 
these fields using the Vacancy Control Bed Maintenance window.   
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Vacancy Control Search  

The Vacancy Control Search window allows local district and voluntary agency workers to 
enter child characteristics and search for a facility with a bed that matches the child’s needs. 
Searches can be conducted for both an individual child or sibling groups. Workers can 
review the results of this search and select a facility from the list. Once a facility has been 
selected, workers can view the status of all beds in that facility and “Reserve” or “Occupy” a 
vacant bed(s). Two different types of vacancy control searches can be conducted from this 
window: 

• An Element Search for vacancies in Foster Boarding Homes (FBH) or 
Congregate Care Facilities (CCF); or  

• An Exact Search using either Resource ID or Vendor ID. 

To access this window, select “Vacancy Control Search” from the Options drop-down menu 
on the CONNECTIONS Toolbar. Workers must have the “Vacancy Control Search” 
Business Function (BF) to access this option. 

 
 

The Vacancy Control Search window is divided into two sections, the tab section and a 
button section. The tab section has two separate tabs, the Search tab and the Bed 
Characteristics tab. Both contain fields and grids that allow workers to enter information 
that is used to conduct the search. 

Conducting the Search 
When the Vacancy Control Search window is first opened, only the Search tab is enabled. 
The Bed Characteristics tab becomes enabled after a type of search is selected. The type 
of search selected by the worker determines the:  

• Required search criteria; 

• Filters that can be added to narrow the search; and 

• Type of results displayed in the Vacancy Control Facility Search Results window. 
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The Search Tab — Vacancy Control Search  

The Search tab is divided into three sections: Search Elements, Exact Search and Search 
Filters. To conduct a search using elements, workers must select either Foster Boarding 
Homes or Congregate Care Facilities from the Type of Search drop-down list located in the 
Search Elements section. Foster Boarding Homes include Certified Foster Homes and 
Foster Adoptive Homes. Congregate Care Facilities include Agency Boarding Homes, 
Group Homes, Group Residences and Institutions. 

 
 

To conduct an Exact Search, workers must enter either the Resource ID or Vendor ID. 
Exact searches are “filtered” by the search criteria. Filtering eliminates results that do not 
match. Entering an Agency ID, Facility type or Program type that meets the child’s needs, 
can also filter the search results. For more information on filtering a search, refer to Search 
Filter section on page 11. 
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Search Elements 
Vacancy Control Search provides workers with the flexibility 
to search for a single bed or for sibling groups. The 
information entered in the required fields will differ 
depending on whether the search is for a single bed or a 
sibling group. When searching for a single bed, the search 
criteria entered are specific for the child in need of 
placement. When searching for a sibling group, the search 
criteria entered represents an overall summary of the 
required number of beds by gender, age ranges by gender 
(widest range) and the Bed Characteristics (highest severity 
level).  

Required fields for each search type highlight in yellow. 
When conducting a search for a Foster Boarding Home 
using Search Elements, the following fields on the Search 
tab are required: 

• Type of Search  
Select Foster Boarding Homes. 
 

• Borough/County: (of Primary Address)  
The borough for the child’s last known primary 
address. 
Allows a worker to conduct a search by selecting a specific borough, county, 
statewide, NYC wide, or out of state. The Borough Sort/Filter Option check box in 
the Search Filter section is only visible when a borough is selected from the drop-
down list. 
 

 

When searching for a large 
sibling group, workers may 
want to lower the number of 
required beds used in the 

search to increase the 
number of results. The beds 

listed in Vacancy Control 
represent the foster parent’s 
preferred number of beds. 

Some Foster Homes may be 
certified for more beds.  

To accommodate the 
placement of large sibling 
groups, a waiver may be 
requested to exceed the 

licensed number of beds for 
a facility (up to eight).  

• Community District: (of Primary Address)  
The NYC/CD for the child’s last known primary address. This field is required 
when a NYC borough is selected in the Borough/County field. 
Allows for a search to be conducted for a bed within a specific NYC/CD. The 
Community District Sort/Filter Option check box in the Search Filter section is 
only visible when a Community District is selected from the Community District 
drop-down list. Select “Unknown” from the drop-down list when the CD is 
unknown. 
Note: When Unknown is selected from the CD drop-down list the Community 
District Sort/Filter Option check box is not visible and the Borough Sort/Filter 
Option check box is disabled.  
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• Male Age Range 
Minimum Year and Maximum Year  

 

Age Range 

When searching for a single 
bed, workers can either list 
the child’s age in both the 
Minimum Year and Maximum 
Year fields, or an estimated 
age range based on the 
child’s expected ages upon 
discharge. 

When searching for a bed for 
a child less than 1 year old, 
enter “0” in the Minimum 
Year field. Enter “0” or the 
child’s expected age upon 
discharge in the Maximum 
Year field. 

When searching for a sibling 
group, enter the youngest 
child’s current age in the 
Minimum Year and the oldest 
child’s current age or 
expected age upon 
discharge in the Maximum 
Year field. 

• Female Age Range 
Minimum Year and Maximum Year  

• Required Number of Male Beds and/or 
Required Number of Female Beds 
If “0” is entered for Required Number of Beds in 
a FBH search, at least one characteristic from 
the Bed Characteristics tab must be added. By 
entering “0,” workers are able to search for beds 
that are not currently available and check the 
date the bed is expected to be vacant.   
 

When conducting an Element Search for a Congregate 
Care Facility, the following fields on the Search tab are 
required: 

• Type of Search  
Select Congregate Care Facilities. 

• Borough/County: (of Primary Address) 
The borough for the child’s last known primary 
address. 
Allows a worker to conduct a search by selecting 
a specific borough, county, statewide, NYC wide 
or out of state.  

• Male Age Range 
Minimum Year and Maximum Year  

• Female Age Range 
Minimum Year and Maximum Year  

• Required Number of Male Beds and/or Required Number of Female Beds 
If “0” is entered for Required Number of Beds in a CCF search, it is not 
necessary to enter bed characteristics. By entering “0,” workers are able to 
search for beds that are not currently available to determine if a bed with the 
needed characteristics exists or check when a bed is expected to be vacant.  

Exact Search  
When conducting an Exact Search the following fields on the Search tab are required: 

• Resource ID; or 

• Vendor ID.  

Only numeric entries are allowed in the Resource ID field. Alphanumeric entries are allowed 
in the Vendor ID field.  
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When workers from voluntary 
agencies enter the Vacancy 
Control Search window, their 
Agency ID is pre-filled in the 
Agency ID field. This field is 

view-only for voluntary 
agencies, allowing them to 

search for homes within their 
own agency only.  

In addition to these required fields, one of the three 
optional fields located in the Search Filters section on 
the Search tab can be used to narrow the search. 
These fields are Facility Type (Certified Foster Home 
or Foster/Adoptive Home for FBH or Agency Boarding 
Home, Group Home, Group Residence or Institution 
for CCF), Program Type (e.g., Mother/Child, 
Emergency, Therapeutic) and Agency ID (the 
agency’s three digit alpha-numeric identifier). When a 
search is filtered using one of these fields, the results 
of the search will only include beds that match the 
filter. For example, if you enter an Agency ID, your 
results will only include beds within that agency.  

The Search Filters section may also display the following two sort/filter option check boxes:  

• The Show results for <Borough> only check box displays when a New York 
City borough is entered in the Borough/County field. This check box is 
automatically selected when it displays. If the search is conducted with this check 
box selected, the search results are filtered, returning only the homes/facilities in 
the selected borough in the search results. If you de-select this check box, the 
search results are sorted, displaying facilities in all New York City boroughs with 
the targeted borough from the Borough/County field at the top of the list. 

• The Show results for <CD> only check box displays only when you select a CD 
in the Community District field. When this check box displays, it is automatically 
selected and the Show results for <Borough> only check box disables. If the 
search is conducted with this check box selected, the search results are filtered, 
returning only the facilities in the selected CD in the search results. If you de-
select this check box, the Show results for <Borough> only check box 
enables. If both check boxes are de-selected, the search results are sorted; 
displaying facilities in all New York City CDs, with the targeted borough and CD 
at the top of the list.  

 

 
 

 



 

The Bed Characteristics Tab — Vacancy Control Search  

The Bed Characteristics tab displays a list of all characteristics for the selected Type of 
Search (Congregate Care Facility or Foster Boarding Home). This tab provides workers with 
the ability to add characteristics to the search by selecting the severity level appropriate for 
the child in need of placement. 

Congregate Care Facilities 

 
 

When “Congregate Care Facilities” is chosen as the type of search, a list box with three 
columns displays.  

• The Category column displays a list of 5 characteristics groups that are allowed 
for resources in that type of search. The Category groups are Education, 
General, Physical, Psychiatric, and Psychosocial.  

• The Characteristic column displays a view-only list of characteristics (e.g., 
speech, mental retardation) that are allowed for resources in that type of search. 
There are multiple characteristics for each Category. 
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• The Severity column allows workers to select the severity level for the 
associated characteristic by using a drop-down list. The list includes the severity 
number and a brief description. The range for severity levels in a Congregate 
Care Facility is 0-4. The choices for HIV are “Yes” and “No.”  
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Foster Boarding Homes 

When “Foster Boarding Homes” is chosen as the Type of Search, a list box with two 
columns displays. The Characteristics column displays a view-only list of characteristics 
(e.g., Behavioral, HIV, Educational) that are allowed for resources in that type of search. 
The Severity column allows workers to select the severity level for the associated 
characteristic by using a drop-down list.  

 

The minimum – maximum range for Foster Boarding Homes is 0-3. The choices for 
Physical, Learning, Emotional and Behavioral Characteristics are:  

• 0 — NA (no known condition or problem) 

• 1 — Mild 

• 2 — Moderate 

• 3 — Severe 
The choices for HIV are “Yes” and “No.” Please refer to Appendix A on page 45 of this guide 
for the NYC/ACS definitions for bed characteristic severity levels in Foster Boarding Homes. 

The Bed Characteristics tab also displays the Type of Search and Number of Beds 
fields. These fields are view-only and display information entered on the Search tab. 
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The lower section of the window contains the buttons. The following table provides the name 
of each button and a description of the button’s function. 
 

Button Name Description 

Clear Clears all search fields Vacancy Control Search window. 

“Clear” can also be selected from the File drop-down menu. 

Search Initiates a search for facilities based on the criteria entered 
in the Vacancy Control Search window. The results of this 
search display in the Vacancy Control Facility Search 
Results window.  

The Search button is enabled when all required fields have 
been completed for the desired type of search.  

“Search” can also be selected from the Options drop-down 
menu. 

Close Closes the Vacancy Control Search window. 

“Close” can also be selected from the File drop-down menu. 
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Reviewing the Results 
A Vacancy Control Search returns facilities that meet or exceed the search criteria entered 
in the Vacancy Control Search window. Only facilities with the status of Accepted–Active are 
included in the results. Facilities in Applicant or Closed status will not return in the search. 
Facilities that are designated as “Closed To Intake” by the searching district or owned by an 
agency that is designated as “Closed To Intake” are not included in the results. The results 
display in the Vacancy Control Facility Search Results window.  

 
The maximum number of facilities returned is 200. If more than 200 facilities matched the 
search criteria, the following message displays:  

“There were more than 200 facilities that match the Search Criteria entered. 
 Only the first 200 facilities will be displayed.” 

 

If no facilities match the search criteria, the following message displays: 

“No matches were found for the search parameters.” 

All elements in the Vacancy Control Facility Search Results window (e.g., the Male Age 
Range and Type of Search fields) are view-only. This window is divided in to three 
sections. The header section at the top contains fields that are pre-filled with the search 
criteria entered by the worker in the Vacancy Control Search window. Only fields that were 
used in the search will be populated.  
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The middle section contains the facility results grid. This grid contains the following columns 
that provide specific information for each of the facilities returned in the results:  

• Closed to Intake (Y/N) 
• Borough/County 
• CD 
• Vacancies 
• CD/Borough Award (Y/N) 
• Agency Name 
• Facility Name 
• Address 

• City 
• State 
• Zip 
• Phone 
• Vendor ID 
• Resource ID 
• Facility Type 

Use the horizontal scroll bar at the bottom of the grid to scroll to the right to view all of the 
columns. Before viewing all of the columns, you may want to note the line number for the 
facility prior to using the scroll bar. The information displayed in these columns is view-only. 
If any of this information needs to be updated, the worker who maintains records for the 
facility must make the changes in the appropriate windows.  

Two of the columns display information from other Vacancy Control windows: 

• The Closed To Intake column displays an indicator next to the facilities that are 
designated as Closed To Intake by another district or that are owned by an 
agency that is designated as Closed To Intake by another district. For more 
information on Closed To Intake, refer to the Vacancy Control Closed To Intake 
section on page 38. 

• The CD/Borough Award Indicator column displays an indicator (“Y” for yes or 
“N” for no) next to facilities that are authorized by an agency that is awarded a 
neighborhood based service contract. For more information on CD/Borough 
Awards, refer to the Vacancy Control CD/Borough Award section on page 41. 

The lower section of the window contains the Total Facilities Returned field and the Sort, 
Bed Detail and Close buttons. The following table provides the names for each button and 
a description of the button’s function. 
 

Button Name Description 

Sort Opens a sort dialog box. Workers may select one, two or 
three columns to use to re-sort the Facility Results list. 

Bed Detail Opens the Vacancy Control Bed Detail window. 

The Bed Detail button becomes enabled when a facility is 
selected from the list. 

Close Closes the window. 

“Close” can also be selected from the File drop-down menu. 
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When the Vacancy Control Facility Search Results window is first opened, the facilities are 
sorted based on the type of search that was conducted. The default sort for Foster Boarding 
Homes is: 

• Borough/County 

• NYC/CD (targeted CD displayed first with remaining CDs following in numerical 
order) 

• NYC/CD Award  

• Facility Name (alphabetically in ascending order) 
For example, if you are searching for a bed in CD 04 in the Bronx, the results will list CD 04 
in the Bronx first. All non-targeted CDs in the Bronx will display in numerical order after the 
targeted CD (04, 01, 02, 03, 05). Facilities with a CD Award will display higher on the list 
(within that CD) than other facilities from that CD. 

The default sort order for Congregate Care Facilities is: 

• Borough/County 

• NYC/CD  

• Facility Name (alphabetically in ascending order) 
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Sorting the Results 
The results on the Vacancy Control Facility Search Results window can be re-sorted using 
either of the following two methods described below.  

Method 1—Sorting the List using the Sort button: 

1. Click on the Sort button in the lower section of the Vacancy Control Facility 
Search Results window.  
A Sort box containing three drop-down lists displays. These lists have the 
names of each column heading on the facility result grid. Workers are able to 
sort the list by selecting one, two or three columns. 

 

2. Select the name of the column from the first drop-down list.  
The first column represents the primary sort. 

3. Click on either the Ascending or Descending radio button.  

4. If desired, select the name of the column from the second drop-down list. 
The second column represents the secondary sort. 

5. Click on either the Ascending or Descending radio button.  

6. If desired, select the name of the column from the third drop-down list. 
The third column represents the tertiary sort 

7. Click on either the Ascending or Descending radio button.  

8. Click on the OK button to sort the results using these choices, or click on the 
Cancel button to return to the list without changing the sort.  
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Method 2—Sorting the List using the Column Header or Footer: 

• Click on a column header. 
The results are re-sorted in ascending order by the selected column. 

Or 

• Click on the column footer. 
The results are re-sorted in descending order by the selected column. 

Selecting a Facility 
A facility can be selected from Vacancy Control Facility Search Results window by clicking 
on the gray button to the left of the first column. Only one facility can be selected at a time. 
Once a facility is selected, the Bed Detail button becomes enabled. Click on the Bed Detail 
button to display the Vacancy Control Bed Detail window.  

Viewing the Vacancy Control Bed Detail window 
The Vacancy Control Bed Detail window displays a list of all beds and bed characteristics 
for the facility that was selected from the Vacancy Control Facility Results window. Workers 
are able to use this window to “Reserve” or “Occupy” a vacant bed or beds. This window is 
divided into three sections, the header, a middle section with two tabs and a lower section 
with buttons.  
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The header section at the top of the window displays the following view-only information for 
the selected facility: 

• Resource Name 

• Agency  

• Resource ID 

• Address  

• Sub Agency  

• Vendor ID  

• Phone 

• Borough/County 

• CD (NYC only) 

• Facility Type 
 

The middle section of the window contains two tabs, the 
Beds tab and the Bed Characteristics tab. When the 
window is first opened, the Beds tab displays.  

 

The Beds Tab — Vacancy Control Bed Detail  

The Beds tab displays bed information on all beds for the 
selected facility. The information that is contained on this 
tab varies, depending on the type of facility (FBH or CCF) 
that was selected on the Vacancy Control Search window. 
The Status, Child Info and Date Bed Expected Vacant 
fields are modifiable. The remaining fields are pre-filled with 
view-only information. 

The Status field allows workers to view the availability of a 
bed. When the status of a bed is “Vacant,” workers can 
select the bed and click on either the Reserve button or the Occupy button in the lower 
section of the window.  

 

When selecting a bed 
compare the child’s needs to 

the bed characteristics. 
Select the bed that has the 

lowest severity levels and still 
meets the child’s needs. 

This will ensure that children 
requiring beds with higher 

severity levels are not closed 
out of these beds by children 

with lower severity levels. 

 

Reserved Status 

The two-hour limit refers to 
consulting with the agency 
regarding the placement. 
This limit does not imply  
that the child has to be  
physically in the home  
within the two hours.  

Workers can reserve up to 
five beds per child.  

A bed can be left in Reserved status for up 2 hours 
before automatically changing back to Vacant status. 
The worker who reserved the bed or a staff person 
(supervisor or above) in the unit hierarchy is able to 
unreserve the bed within the two-hour limit. Unreserving the 
bed changes the status of the bed back to Vacant. 

Workers must continue to follow current procedure and 
consult with the agency regarding the appropriateness 
of the placement prior to changing the status of the bed 
to Occupied.  

When a bed is in Reserved or Occupied status, the 
Reserved by Worker ID field displays the ID of the worker 
who changed the status. When a bed is in Reserved status, 
only the worker who reserved the bed or a staff person 
(supervisor or above) in the unit hierarchy can change the 
bed to Occupied or Unreserved. 
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To find contact information in CONNECTIONS about the worker listed in the Reserved By 
Worker ID field, conduct a Staff Search from the CONNECTIONS Toolbar. 

1. Click on the STAFF button on the CONNECTIONS Toolbar. 
The Staff Search Criteria window displays. The Agency field for the worker 
conducting the search is pre-filled and the Active check box is selected. The 
Agency field is not enabled when the search is conducted using the Person 
ID number. 

2. Enter the number that was listed in the Reserved by Worker ID field in the 
Person ID field in the upper portion of the window. 

3. Click on the Search button. 
The Staff List displays with the results of your search. 

4. Select the name from the list. 

5. Click on the Detail… button. 
The Staff Detail window displays. 

6. To close the Staff Detail window, click on the Cancel button. 
The Staff List displays. 

7. To close the Staff List, click on the Close button. 
The Staff Search Criteria window displays. 

 

When reserving or occupying a bed, the worker (or a worker in the unit hierarchy) is able to 
enter information into the Child Info field and the Date Expected Vacant field. Information 
in the Child Info field is removed when the bed status changes to Vacant or Temporarily 
Unavailable. Information in the Date Expected Vacant field is removed when the bed status 
changes to Vacant. 

The child’s gender and age (e.g., M 12/06/91) should be entered in the Child Info field in 
the first 10 spaces. To enter more information, you may use the remaining 15 spaces 
allotted for this field. This information is important and provides a more complete view of the 
home for other workers making placement decisions. If there is a known date that the child 
expected to leave placement (e.g., a Planned Discharge) then this date should be entered in 
the Date Expected Vacant field. 
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Five additional columns display on this tab for Foster Boarding Homes. These columns 
capture the characteristic severity levels for Behavior, Emotional, Physical Learning and 
HIV.  

Column Name Description 

Physical 

Learning 

Emotional 

Behavioral 

The following choices represent the severity levels for these 
four columns: 

• 0 — NA (no known condition or problem) 

• 1 — Mild 

• 2 — Moderate 

• 3 — Severe 

HIV The choices for HIV are: 

• — No 

• — Yes  

 

The Bed Characteristics Tab — Vacancy Control Bed Detail  

The Bed Characteristics tab displays the characteristics and severity levels of the selected 
Congregate Care Facility’s beds. Access to the Bed Characteristics tab is only available 
for beds in Congregate Care Facilities that have characteristics with severity levels greater 
than zero. 
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The lower section of the window contains the Total Bed field. This field is view-only and is 
pre-filled with the number of beds listed on the Beds tab. This section also contains the 
buttons. The following table provides the names for each button and a description of the 
button’s function. 

Button Name Description 

Sort Re-sorts the list of beds. 
“Sort” can also be selected from the Options drop-down 
menu. 

Previous Click on this button to move to the previous facility in the 
Vacancy Control Facility Search Results window.  
If information is entered but not saved when the Previous 
button is clicked, the following message displays:  
“Do you want to save changes? If No, modified data and/or 
narratives will be lost” 
“Previous Facility” can also be selected from the Options 
drop-down menu. 

Next Click on this button to move to the next facility in the 
Vacancy Control Facility Search Results window. 
If information is entered but not saved when the Next button 
is clicked, the following message displays: 
“Do you want to save changes? If No, modified data and/or 
narratives will be lost” 
“Next Facility” can also be selected from the Options drop-
down menu. 

Reserve Click on this button to reserve a vacant bed. 
“Reserve” can also be selected from Beds sub-menu 
located in the Options drop-down menu.  

Occupy Occupies a vacant or reserved bed. Only the worker or a 
worker in the unit hierarchy can occupy a bed in reserved 
status.  
“Occupy” can also be selected from Beds sub-menu located 
in the Options drop-down menu. 

Unreserve Changes the bed back to the previous status of vacant. Only 
the worker or a worker in the unit hierarchy can unreserve a 
bed in reserved status. 
“Unreserve” can also be selected from Beds sub-menu 
located in the Options drop-down menu. 

Save Saves the changes.  
“Save” can also be selected from the File drop-down menu. 

Close Closes the window without saving the changes. 
“Close” can also be selected from the File drop-down menu. 

Print Prints the Vacancy Control Placement Tracking Report. 
“Print” can also be selected from the File drop-down menu. 
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Reserving or Occupying a Bed 

1. Select the bed to be Reserved or Occupied. 
If the bed is in Vacant status, the status can be changed to Reserved or 
Occupied. If the bed is in Reserved status, only the worker who reserved the 
bed, or a staff person in the unit hierarchy can change the status to Occupied 
or Unreserved.  

2. Click on the Reserve button to change the status to Reserved or on the 
Occupy button to change the status to Occupied. 
The Bed Detail Notes window opens. 

 

3. Enter information into the Child Info field.  
Enter the child’s gender and date of birth in the first 10 spaces (e.g., M 
12/06/91) of the 25-character field. 

4. If the date the child is expected to leave is known (e.g., a Planned Discharge) 
then enter this date in the Date Expected Vacant field.  
NOTE: If you have entered information into 
either the Child Info field or the Date 
Expected Vacant field, check for accuracy 
before you click on the OK and Save 
buttons. If the information has already been 
saved and you need to make changes, you 
must re-open the Bed Detail Notes window. 
To re-open the Bed Detail Notes window, 
you must select the bed and click on either 
the Unreserve or Occupy buttons.  

 

When a child is moved  
from a bed, the bed must be 

updated using Vacancy 
Control Bed Maintenance to 

reflect the new status. 

Information in the  
Child Info and Reserved  

By Worker ID fields is 
removed when the bed 

status changes to Vacant or 
Temporarily Unavailable.  

Information in the Date 
Expected Vacant field is 
removed when the bed 

status changes to Vacant. 

5. Click on the OK button. 

6. Click on the Save button to save your 
changes.  
Before you close the Bed Detail window for 
this resource, record the Resource Name, 
Resource ID, Agency Phone number and 
any other information you may need when 
contacting the agency concerning the 
placement. 
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Vacancy Control Placement Tracking Report 
The Vacancy Control Placement Tracking Report provides bed information for beds in 
Occupied status for workers and supervisors. Workers may select one or more beds from 
the list in the Bed Detail window. Click on the column to the left to select one bed. To select 
multiple beds that are adjacent, press the Shift key and click to select. If the multiple beds 
are not adjacent, press the Ctrl key and click to select.  

1. Select one or more beds in Occupied status from the list in the Bed Detail 
window. 

2. Click on the Print button or select “Print” from the File drop-down menu. 
A Preview of the Vacancy Control Placement Tracking Report displays. 

 
 

3. Click on the Print  icon. 
The print dialog box displays. 

4. Click on the OK button.  

5. Click on the Close button.  
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Vacancy Control Bed Maintenance  

Beds, Bed Characteristics, and other factors change and local districts and voluntary 
agencies must maintain accurate records to optimize their placement potential. Build 15.1 
introduces the Vacancy Control Bed Maintenance window that provides workers with the 
ability to identify beds in Congregate Care Facilities and Foster Boarding Homes that are 
available for placement and offers designated workers the flexibility to make modifications to 
beds (e.g., add beds, delete beds, change bed characteristics, add comments) through the 
worker’s Assigned Workload (including unit hierarchy access to the Assigned Workload) or 
owned by their agency. 

In order for bed information to be maintained, the facility 
must be in either Accepted–Active or Applicant status. 
Note: Only Facilities in Accepted-Active status will return in 
Vacancy Control Search.   

If a child’s placement in a 
bed changes the foster 

parent’s overall preference, 
all other beds in the home 
must be updated to reflect 

these changes.  

For example, if a male child 
occupies one of two beds in 

a room originally available for 
either males or females, then 

the worker who is 
responsible for maintaining 

the foster home must update 
the vacant bed to reflect a 

change in gender preference 
for the vacant bed. 

Workers performing modifications to beds using the 
Vacancy Control Bed Maintenance window must have the 
new “Bed Maintenance” Business Function (BF) as well as 
one of the following conditions:  

• The worker must be from the same 
district/agency that owns the facility 

or 

• The facility must be on the worker’s Assigned 
Workload. 
Note: Workers assigned to a FAD stage are able 
to view the Vacancy Control Bed Maintenance 
window from the Task List. This provides FAD 
workers who are not designated to maintain 
Vacancy Control with access to information 
contained in Vacancy Control that may be 
relevant to certification and licensing 
information. 
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You can access the Vacancy Control Bed Maintenance window from either your Assigned 
Workload or from the CONNECTIONS Toolbar using one of the following navigational paths:  

• When the facility is on your Assigned Workload, click on the Work button on the 
CONNECTIONS Toolbar. Select the facility from the Assigned Workload and 
click on the Tasks… button. Select “Vacancy Control Bed Maintenance” from the 
Task List and click on the Detail… button.  

 
• When the facility is not on your Assigned Workload, click on the RSRC button on 

the CONNECTIONS Toolbar to conduct a Resource Search for the facility. Select 
the facility from the Resource List and click on the Detail button. Select “Vacancy 
Bed Maint” on the Options drop-down menu from the Resource Detail window. 

 
Instructions on how to conduct a Resource Search are provided in the Search Techniques 
Step by Step Guide. This guide is available on the CONNECTIONS intranet site 
http://sdssnet5/ocfs/connect by clicking on the link for Desk/Job Aids.  

CONNECTIONS - System Build 15.1 – Vacancy Control Page 28 

7/24/02 

http://sdssnet5/ocfs/connect


 

The Vacancy Control Bed Maintenance window is divided into three sections, the header, a 
middle section with tabs and a lower section with two buttons. The header section at the top 
of the window is pre-filled with view-only information for the selected facility. 

 

 

The Facility Comments button opens a comments box. When the Vacancy Control Bed 
Maintenance window is opened in modify mode, workers are able to enter additional 
information about the facility that may be useful (e.g., “Foster home is wheel chair 
accessible” or “Foster parent is a registered nurse”). A check mark displays next to the 
Facility Comments button when comments have been saved. 
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The Beds Tab — Vacancy Control Bed Maintenance 

The Beds tab is always active when the window is first opened. The Beds tab displays a 
grid that lists the beds that are maintained in Vacancy Control for the selected facility. These 
beds represent the foster parent’s or agency’s preferred number of beds and may not match 
the total number of beds licensed for the home. Some Foster Homes may be licensed for 
more beds. The number of beds and age ranges that display on the grid must be within the 
licensing certification.  

 
The columns that display in the grid will differ depending on whether the Vacancy Control 
Bed Maintenance window was opened for a Foster Boarding Home or a Congregate Care 
Facility.  

 
Click on the column to the left to select a bed. To modify Bed Location, click on the cell and 
enter information directly in the cell. To modify the Status of the selected bed or Bed 
Characteristics for a FBH, click on the cell in the column to display a drop-down arrow. Click 
on the drop-down arrow to open a drop-down list.  
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The following table provides the name of each column and a brief description of the function. 

Column Name Description 

Bed ID Displays a unique identifier that links beds for internal 
tracking. This field is view-only. 

Status Displays the current status of a bed. In modify mode, 
workers are able to change the bed status of beds with a 
status of Occupied, Vacant or Temporarily Unavailable (for 
less than 30 days). Beds that are in Reserved status can 
only be modified by the worker who reserved the bed or a 
staff member in the unit hierarchy.  

Male Min Year 

Male Max Year 

Female Min 
Year 

Female Max 
Year 

Age range information is modifiable and must be within the 
licensing age range. These fields are view-only when the 
window is opened in browse mode.  
Note: Enter “O” in the minimum age range when a bed 
is suitable for a child less than 1 year old.  
Leave the age fields blank if the bed is not suitable for a 
gender.  

Reserved by 
Worker ID 

Displays the Person ID of the worker who changed the 
status of the bed to Reserved. This field is view-only. The 
data in this field is removed when the bed status changes to 
Vacant or Temporarily Unavailable. To locate further 
information in CONNECTIONS about the worker, refer to 
page 22 of this guide. 

Child Info Allows a worker to enter the child’s gender and date of birth 
in the first 10 spaces when reserving or occupying a bed 
(e.g., M 12/06/91). To enter more information, you may use 
the remaining 15 spaces allotted for this field. 

Date Expected 
Vacant 

Allows a worker to enter the date bed is expected to be 
vacant (if known). This information is removed when the bed 
status changes to Vacant. 

Bed Location Allows a worker to enter information on where the bed is 
located by using an identifier. For example, “A1-2” stands for 
Bedroom “A”, Bed “1 of 2.” The modifier “Ther” (Therapeutic 
Contract) is added when appropriate. 
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Five additional columns display on the grid on the Beds tab when Bed Maintenance is 
opened on a Foster Boarding Home. These fields do not display when the window is opened 
for a Congregate Care Facility. These columns provide Bed Characteristic severity levels for 
the selected bed.   

Column Name Description 

Physical 

Learning 

Emotional 

Behavioral 

The following choices represent the severity levels for these 
four columns:  

• 0 — NA (no known condition or problem)  

• 1 — Mild 

• 2 — Moderate 

• 3 — Severe 

HIV The choices for HIV are: 

• No 

• Yes  

 

The Beds tab also contains buttons below the grid. The following table provides the names 
for each button and a description of the button’s function. 

Button Name Description 

Add Beds Adds beds to the facility.  

The Add Beds button is enabled when the window is opened 
in modify mode and the current number of beds is less than 
the licensing capacity.  

“Add Beds” sub-menu can also be selected from the Bed 
Maintenance drop-down menu.  

Delete Beds Deletes existing beds from the facility. Always delete the 
bed in Vacancy Control before changing the bed capacity 
information in the F/A Home License window.  

The Delete Beds button is enabled when the window is 
opened in modify mode and one or more beds is selected.  

“Delete Beds” can also be selected from the Bed 
Maintenance drop-down menu.   

Continued on next page
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Continued from previous page

Button Name Description 

Modify Beds Allows a worker to change existing bed characteristics.  

The Modify Beds button is enabled when the window is 
opened in modify mode and one or more beds is selected. 

“Modify Beds” can also be selected from the Bed 
Maintenance drop-down menu.   

Save Saves the changes.  

“Save” can also be selected from the Bed Maintenance 
drop-down menu. 

Cancel Cancels changes that are in progress. 

“Cancel” can also be selected from the Bed Maintenance 
drop-down menu. 
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The Bed Characteristics Tab — Vacancy Control Bed Maintenance 

The Bed Characteristics tab is enabled when you select one or more beds from the Beds 
tab. A grid containing a list of bed characteristics displays on the tab. The information 
displayed on the grid depends on whether one bed or multiple beds are selected. If one bed 
is selected, the existing characteristics and severity levels for that bed displays on the grid. If 
multiple beds are selected, a list of all possible characteristics displays on the grid. Workers 
are able to select and apply the bed characteristics to all selected beds.  

If the worker does not have the Bed Maintenance BF, the Bed Characteristics tab will be 
enabled only when ONE bed is selected. All fields on the window will be view only. 
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Adding a Bed  
New beds can be added to a selected facility up to the certified capacity. These beds can be 
based on existing beds or added as a “blank” bed record. The number of beds and age 
ranges by gender for each bed must be within the licensing certification. Only one bed can 
be added at a time. 

Adding a Bed based on existing bed information 

1. Click on the Beds tab. 

2. Click on the column to the left of the Bed ID column to select the bed. 

3. Click on the Add Beds button. 
A new bed displays with the characteristics (including severity levels, status and 
bed location) copied from the selected bed. If necessary, modify the copied 
information to accurately represent the new bed. The Bed Location field must be 
updated with the new bed information using an identifier. For example, “A1-2” 
stands for Bedroom “A”, Bed “1 of 2.” The modifier “Ther” (Therapeutic Contract) 
is added when appropriate. This information is required for homes with 
vacancies).   

4. Click on the Save button. 

 

Adding a “Blank” Bed  

1. Click on the Beds tab. 

2. Click on the Add Beds button (without selecting an existing bed). 
A new bed displays with a blank row. 
Enter specific information for the new bed in the blank fields. 

3. Click on the Save button. 

Deleting a Bed 
One or more beds can be deleted from Vacancy Control for a facility at the same time. Note: 
When reducing the licensing capacity for a facility, always delete the beds that are beyond 
the new licensing capacity in Vacancy Control before changing the bed capacity information 
in the F/A Home License window. 

1. Click on the Beds tab. 

2. Click on the column to the left of the Bed ID column to select the bed. 
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3. Click on the Delete Beds button. 
The following message displays: 
”Are you sure you wish to delete this bed?” 



 

4. Click on the Yes button to delete the bed, or on the No button to return to the 
Beds tab without deleting the bed. 

Changing Bed Characteristics  
Bed Characteristics for existing beds can be added, deleted or modified. Age ranges by 
gender on each bed must be kept within the licensing certification. Enter “O” in the minimum 
age range for beds appropriate for children less than one year old. Leave the age fields 
blank when the bed is not suitable for a gender. 

Modifying Severity Levels in a Foster Boarding Home 

1. Click on the Beds tab. 

2. Click on the column to the left of the Bed ID column to select the bed. 

3. Click on the Modify Beds button. 

4. Select the severity level (0,1,2, or 3) from the drop-down list. 

5. Click on the Save button. 
OR 

1. Click on the column to the left of the Bed ID column to select the bed. 

2. Select the severity level (0,1,2, or 3) from the drop-down list for the column (e.g. 
Physical column) for the appropriate row.  

3. Click on the Save button. 
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Modifying Severity Levels in a Congregate Care Facility 

The appearance of the Bed Characteristics tab depends on whether one bed or multiple 
beds are selected.  

One Bed Multiple Beds 

1. Click on the column to the left of 
the Bed ID column to select the 
bed. 

2. Click on the Modify Beds button. 
The Bed Characteristics tab 
displays. When one bed is 
selected, a grid displays with all 
existing characteristics for the 
selected bed. 

3. Click in the cell for the Existing 
Characteristic you want to modify. 

4. Click on the drop-down arrow and 
select the severity level from the 
list.  

5. Click on the Save button. 

6. Click on the OK button. 

1. Click on the column to the left of 
the Bed ID column to select the 
bed. 
To select multiple beds that are 
adjacent, press the Shift key and 
click to select. If the multiple beds 
are not adjacent, press the Ctrl 
key and click to select. 

2. Click on the Modify Beds button 
(or Bed Characteristics tab). 
If multiple beds are selected, a 
grid displays with all Available 
Characteristics to be applied to all 
selected beds. 

3. Click in the cell for the Available 
Characteristic you want to modify. 

4. Click on the drop-down arrow and 
select the severity level from the 
list. 

5. Click on the Save button. 

6. Click on the OK button. 

Changing the Status of a Bed 
The status of a bed in Vacant, Occupied or Temporarily 
Unavailable status can be changed. Beds in Reserved 
status can only be modified by the worker who reserved the 
bed or by a worker in the unit hierarchy. When a child is 
moved from a bed, the bed must be updated to reflect the 
new status. For example, when a child is no longer in 
placement and the bed becomes available, the status must 
be changed from “Occupied” to either “Vacant” or 
“Temporarily Unavailable.”  

 

The status of “Temporarily 
Unavailable” can be applied 

to a bed for less than 30 
days. 

1. Click on the column to the left of the bed to select the bed. 

2. Click on the drop-down arrow in the Status field for that bed. 

3. Select the status from the list. 

4. Click on the Save button. 
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Vacancy Control Closed To Intake  

The Vacancy Control Closed To Intake window allows designated local district and OCFS 
staff to remove facilities from the Vacancy Control Facility Search Results. The Closed To 
Intake status can be applied to: 

• A Facility — to remove the facility from the search results. 

• An Agency — to remove all Congregate Care Facilities and Foster Boarding 
Homes that the agency owns from the search results. 

• A Facility Type within an Agency — to remove all facilities of a selected type 
(e.g., Group Home, Institution) that the agency owns from the search results. 

To make modifications in the Vacancy Control Closed To Intake window, workers must have 
the “Closed To Intake” Business Function (BF). To access the window in view-only mode, 
workers must have the Vacancy Search BF.  

The status of Closed To Intake works differently, depending on whether it was applied by an 
OCFS worker or a staff member from a local district. The following table illustrates how 
Closed To Intake functions when different workers apply the status.  

Designated 
OCFS staff 
applying the 
Closed To 
Intake status 

→ The facility is removed from all Vacancy Control 
Searches for all workers statewide. 

Designated 
Local district 
staff applying 
the Closed To 
Intake status 

→ The facility is removed from Vacancy Control Search 
Results when a worker from the same district as the 
worker applying the Closed to Intake status performs the 
search. 

→ The facility returns with a “Closed To Intake Indicator” 
when a worker from another district performs the search 

 

For example, if a NYC/ACS manager from Kings County (Brooklyn) applies the Closed To 
Intake status to a facility, the facility will not return in Vacancy Control Searches performed 
by NYC/ACS workers from any of the five boroughs. If a staff member from NYS/OCFS, 
non-NYC/ACS districts, or a voluntary agency (and the bed is within their own agency) 
performs the search, this same facility will be included in the Vacancy Control Facility 
Search Results window with a “Y” displayed in the Closed To Intake column.  

Applying the Closed To Intake status is not a permanent change and can be reversed by 
designated local district and OCFS staff. 
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Accessing the Vacancy Control Closed To Intake window: 

1. Click on the Options drop-down menu in the Resource Detail window.  

2. Select Vacancy Control Closed To Intake. 
The Vacancy Control Closed To Intake window displays. 

The Vacancy Control Closed To Intake window is divided into two sections, the header and 
the tab section. The header section at the top of the window is pre-filled with view-only 
information for the selected facility. 

 
The tab section includes two tabs, the Maintenance tab and the Inquiry tab. The 
Maintenance tab is the active tab when workers with the Closed To Intake Business 
Function (BF) open the window. The Inquiry tab is the active tab when workers who don’t 
have the Closed To Intake BF (but have the Vacancy Control Search BF) open the window.  

The Maintenance Tab — Vacancy Control Closed To Intake 

The type of resource selected determines which fields display on the Maintenance tab. 
When the window is opened for a facility, local district workers can click on the Close to 
Intake for [worker’s district] check box to add or remove the Closed To Intake status for the 
facility for the worker’s district. An OCFS worker can use the Close to Intake for ALL check 
box to apply the status to all districts.  
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Applying the Closed To Intake status is not a permanent change and can be reversed by de-
selecting the Close To Intake for [worker’s district] check box. 



 

When the window is opened for an agency, a grid with following two columns displays: 

• Facility Types — contains a view-only list of six facility types.  

• Closed — a check box for each of the six facility types.  

Local district workers can also use the Close Agency to Intake for district [worker’s 
district] check box to add or remove the Closed To Intake status for the entire agency (e.g. 
all Foster Boarding Homes or Congregate Care Facilities within the agency) for the worker’s 
district. OCFS workers can use the Close Agency to Intake for ALL check box to apply the 
status to the entire agency for all districts.  

The Inquiry tab  — Vacancy Control Closed To Intake 

The type of resource selected determines which fields display on the Inquiry tab. When the 
window is opened for a facility, a grid with following two columns displays:  

• Closed to District — lists the districts that added Closed to Intake to the facility.  

• Effective Date — captures the date the status was applied. 
When the window is opened for an agency, a grid with the following three columns displays:  

• Closed to District — lists the districts that added Closed to Intake to the agency.  

• Closed for Facility Types — lists the facility types that the status was applied 
to.  

• Effective Date — captures the date the status was applied.  

 

Vacancy Control Closed To Intake Report  
In support of this function, the “Vacancy Control Closed To Intake Report” was created. This 
report contains a list of facilities and agencies (sorted by district) with detailed information for 
each facility or agency that have a Closed To Intake status. The report is generated weekly. 
All staff on the Closed to Intake Distribution List will be able to view this report from the 
Report List window. This list is maintained by NYS/OCFS. 
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Vacancy Control CD/Borough Award (NYC/ACS only) 

The CD/ Borough Award Maintenance window allows NYC/ACS administration to indicate in 
CONNECTIONS which agencies have been awarded a neighborhood based service 
contract. The CD Awards apply to agencies that license Foster Boarding Homes and the 
Borough Awards apply to agencies that operate Congregate Care Facilities.  

This window is accessed from the Resource Detail window by selecting “Vacancy Control 
CD Awards” from the Options drop-down menu.  

The CD/ Borough Award Maintenance window is divided into three sections, the header, a 
middle section with tabs and a lower section with buttons. The header is pre-filled with view-
only information for the selected agency. 

The tab section is divided into two tabs, the Foster Boarding Homes — CD Awards tab 
and the Congregate Care Facilities — Borough Awards tab.  
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Foster Boarding Homes — CD Awards Tab 

The Foster Boarding Homes – CD Awards tab is always active when the window is first 
opened. This tab displays a list of all NYC Community Districts. A check box next to each 
Community District indicates whether or not the selected agency was given an Award for the 
NYC/CD.  

Workers must have the CD/ Borough Award Maintenance Business Function (BF) to modify 
information in this window. Workers that have the Vacancy Search BF can access the 
window in inquiry mode only. 

 

Adding a Community District (NYC/CD) Award 

1. Click on the checkbox next to the CD to indicate that the selected agency is 
given an Award for the CD. 

2. Click on the Save button to save the changes.  
The Resource Detail window displays. 

Deleting a Community District (NYC/CD) Award 

1. Click on the checkbox next to the CD to remove the indicator. 

2. Click on the Save button to save the changes.  
The Resource Detail window displays. 
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Congregate Care Facilities — Borough Awards Tab 

The Congregate Care Facilities — Borough Awards tab displays a list of all boroughs. A 
check box next to each borough indicates whether or not the selected agency was given an 
Award for the borough.  

Workers must have the CD/ Borough Award Maintenance Business Function (BF) to modify 
information in this window. Workers that have the Vacancy Search BF can access the 
window in inquiry mode only. 

 

Adding a Borough Award (NYC/ACS Only) 

1. Click on the checkbox next to the borough to indicate that the selected agency is 
given an Award for the borough. 

2. Click on the Save button to save the changes.  
The Resource Detail window displays. 

Deleting a Borough Award (NYC/ACS Only) 

1. Click on the checkbox next to the borough to remove the indicator. 

2. Click on the Save button to save the changes.  
The Resource Detail window displays. 
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Updates to the CONNECTIONS Online Help system 

Context-sensitive help information is available for all elements in Vacancy Control windows, 
including tabs, grids, buttons, and individual fields. Click on an element to make that 
element “active” and then press the F1 key on your keyboard to display information about 
that element in Vacancy Control. Once you are in the Help system, the Table of Contents 
enables you to access help information about other elements of Vacancy Control.  

Online Help includes the following features: 

• A Table of Contents allowing access to additional Help information. 

• Index and Search functions providing alternate means of finding information. 

• Hyperlinks appear throughout the Online Help system. These links will take you 
directly to related information such as definitions and procedural guidelines. 

 
In addition to context-sensitive help information about Vacancy Control elements like fields, 
tabs and buttons, the Vacancy Control Help system includes the following additional 
features:  

• Vacancy Control Overview 
A high-level summary of the Vacancy Control system, including a list of its 
features and functions. This overview is accessed directly by clicking on the Help 
menu in a Vacancy Control window and selecting the Vacancy Control Help 
command. 

• “How Do I?” Help 
Information about how to navigate within Vacancy Control and how best to utilize 
its functions. 
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Appendix A 

 

DEFINING MILD, MODERATE AND SEVERE CHILD 
CHARACTERISTICS FOR VACANCY CONTROL MAINTENANCE 

Introduction 

In an effort to achieve maximum efficient vacancy utilization in the new Vacancy Control 
System (in CONNECTIONS), the Office of Placement Administration (OPA) is providing 
definitions of the terms, Mild (1), Moderate (2) and Severe (3) as applied to child and bed 
characteristics. OPA has defined the terms listed below, and illustrated them with specific 
examples of the applicability of the terms to child and bed characteristics. In addition, there 
is a list of “Additional” definitions that may be helpful in maintaining the Vacancy Control 
System. 

Definitions 

The definitions of Mild (1), Moderate (2) and Severe (3) as applies to Behavior, Emotional, 
Physical and Learning characteristics, have varying degrees of subjectivity, from the 
perspective of both the OPA placement worker and the foster care agency Intake 
Coordinator. There are, however, certain guidelines to provide some uniformity of definition:  

• “0”- usually applies to characteristics that present no known condition or problem; or, 
child and bed characteristics may be left blank. 

• Mild - usually applies to characteristics that present a minor condition or problem 
that does not significantly affect functioning. Mild is represented by the Number 1. 

• Moderate - usually applies to characteristics that present a condition or problem that 
may affect functioning and that may require specialized services or treatment. 
Moderate is represented by the Number 2. 

• Severe - usually applies to characteristics that present a serious condition or problem 
that significantly affects functioning and that requires intensive services or treatment. 
Severe is represented by the Number 3. 
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Specific Examples 
Following, are some examples of Mild, Moderate and Severe characteristics to illustrate the 
definitions: 
Behavior: Frustration 
1. Mild  - Easily frustrated, but remains under control 
2. Moderate - Loses temper easily, but exhibits no violent behavior  
3. Severe - Loses temper and loses control, causing harm to self, others or property 
Emotional: Bed Wetting 
1. Mild - Occasional bed wetting 
2. Moderate - Some bed wetting that may require some treatment 
3. Severe - Frequent bed wetting that requires special treatment 
Physical: Newborn (Substance Abuse) 
1. Mild - Evidence of substance abuse during pregnancy- no sign of any delay at this time 
2. Moderate - Evidence of substance abuse during pregnancy- some indication of delay 
3. Severe - Evidence of substance abuse during pregnancy, significant physical and 
developmental delays; fetal alcohol syndrome 
Learning: School Achievement 
1. Mild - Minor difficulty in maintaining grades 
2. Moderate - Some learning problems - 2 levels below age group in reading and math  
3. Severe - Major learning problems requiring intensive educational testing and services 
Additional Definitions 
In addition to the definitions described above, there are two characteristics that require 
explanation:  
• To describe a child’s HIV status, the indication is “YES” / “ NO.”  
• To describe the range of intelligence for a child, the following levels apply: 

Average Intelligence- 90-109> 
Borderline Retardation- 70-89 (70 
and above is within the normal range) 
Mild Retardation- 55-69 
Moderate Retardation- 40-54 
Severe Retardation- 25-39 
Profound Retardation - 0-24 
Un-testable- <0  
 

* Mild - Capable of developing social and verbal 
skills up to a 6th grade level and sufficient for 
self-support 
* Moderate - Capable of some communication 
and learning vocational skills; difficulty with 
social functioning 
* Severe - Poor motor and verbal skills; some 
limited ability to perform supervised work 
* Profound - Requires constant care, structured 
environment; limited self-care 
* Un-testable - Requires constant care and 
supervision; unlikely to acquire self-care skills. 
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